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Overview of SAS Enterprise Guide Administration

Administering SAS Enterprise Guide in your organization involves creating an
environment for SAS Enterprise Guide users that contains all of the SAS resources and
data that your users need to perform their jobs. SAS Enterprise Guide users should be
able to complete tasks and access the data that they need, but be prevented from
performing tasks that they are not allowed to do or accessing data that they are not
allowed to use. These objectives are met by creating definitions in metadata for the SAS
resources that are accessed by SAS Enterprise Guide users. These definitions enable
SAS Enterprise Guide users to access data transparently, without knowing the actual
location of the data. If you are using SAS Enterprise Guide in a SAS Intelligence
Platform environment, metadata definitions can be used by both SAS Enterprise Guide
and other Intelligence Platform applications (such as SAS Data Integration Studio and
SAS Information Map Studio). This lets multiple SAS applications access a consistent
set of resources and data.

To perform SAS Enterprise Guide administration tasks, you need to use both SAS
Enterprise Guide Explorer and SAS Management Console. SAS Management Console
is the main administration tool for the SAS Intelligence Platform, and enables you to
create definitions for servers, libraries, users, groups, and security settings. SAS
Enterprise Guide Explorer is a secondary administration tool that provides several
functions that are specific to SAS Enterprise Guide. The application enables you to
identify metadata sources, create definitions for servers and libraries, and administer a
common environment configuration for all SAS Enterprise Guide users. Most tasks that
can be performed in SAS Enterprise Guide Explorer can also be performed in SAS
Management Console, and there are some tasks (such as defining users and groups and
setting up security) that can be performed only in SAS Management Console. Functions
such as importing tasks and deploying metadata profiles are available only in SAS
Enterprise Guide Explorer.

Figure 1.1 on page 2 illustrates how SAS Enterprise Guide uses the metadata
definitions that are created by SAS Enterprise Guide Explorer and SAS Management
Console to access SAS resources such as servers and libraries.
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Figure 1.1 Creating and Accessing Metadata Definitions
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This document does not contain detailed information about the administration tasks
that are required to set up a metadata repository and create metadata definitions that
are common to all SAS Intelligence Platform applications (such as user definitions and
security settings). For information about these procedures, see the SAS Intelligence
Platform Administration documents that are listed in Appendix 1, “Recommended
Reading,” on page 51.

You can also use SAS Enterprise Guide without a connection to a SAS Metadata
Server. In this configuration, SAS Enterprise Guide works on a local SAS server, and
cannot use any functions that require a metadata connection. The functions that are
not available include the following:

O stored processes
0 information maps
O role-based settings

O library assignments in SAS Enteprise Guide Explorer (only project libraries are
available)

o SAS folders
O publishing

What Is SAS Enterprise Guide?

SAS Enterprise Guide is a thin-client Windows application that provides a
point-and-click desktop interface to SAS (9.2 or later) and can be used to connect to
various server platforms, including UNIX, z/OS, and Windows. It communicates with
SAS to access data, perform analysis, and generate results (such as graphics, PDF files,
and HTML files). From SAS Enterprise Guide you can access and analyze many types
of data, such as SAS data sets, Microsoft Excel spreadsheets, and third-party
databases. You can either use a set of task dialog boxes or write your own SAS code to
perform your analysis. The application helps users to produce results easily, regardless
of their SAS knowledge.
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SAS Enterprise Guide uses a distributed computing model of network servers that
enable users to access data on multiple platforms quickly and easily.

What Is SAS Enterprise Guide Explorer?

SAS Enterprise Guide Explorer is an application for SAS administrators that serves
as a resource manager for SAS Enterprise Guide. The resource definitions are stored in
a metadata repository, thus enabling all users to access the same resources.

With SAS Enterprise Guide Explorer, you can perform the following tasks:

O manage profile definitions by specifying access information for metadata sources
and setting an active profile

O create a shared profile definition that is accessed by all SAS Enterprise Guide
users and can be automatically updated

O create metadata definitions for SAS libraries
O browse the contents of servers and libraries
O browse SAS folders and their contents

Updates to This Guide

Updates to this guide are available from http://support.sas.com.

Getting Help

From the SAS Enterprise Guide Explorer main menu, click Help » SAS Enterprise
Guide Explorer Help, or click the Help button in any SAS Enterprise Guide Explorer
dialog box to get help for that dialog box.

For technical assistance, contact SAS Technical Support or visit
http://support.sas.com.


http://support.sas.com
http://support.sas.com
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What Is a Profile?

A profile defines the connection between SAS Enterprise Guide and a SAS Metadata
Server. The SAS Metadata Server contains metadata definitions for objects such as
workspace servers, libraries, and users that are used by SAS Enterprise Guide and
other applications. After you use a profile to connect to a source of metadata definitions,
you can use SAS Enterprise Guide Explorer to define libraries. However, the primary
application for creating metadata definitions is SAS Management Console, which you
can also use to define libraries, as well as servers, users, groups, and authorization
settings.

If you use SAS Enterprise Guide without a profile, you can access only a SAS server
that is installed on your local machine. You cannot define libraries or share SAS
resources with other SAS applications.

What Is a Metadata Server?

A metadata server contains definitions for objects such as workspace servers and
libraries that are used by SAS Enterprise Guide and other applications. Metadata
definitions in a SAS Metadata Server can be used by many other applications besides
SAS Enterprise Guide, which enables you to use a single set of object definitions for all
SAS applications in your organization.

You can use SAS Enterprise Guide Explorer to define libraries in a SAS Metadata
Server. Other metadata definitions (such as servers, users, and SAS content) are
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defined by SAS Management Console or other applications such as SAS Data
Integration Studio.

Setting up metadata servers is an essential part of SAS Enterprise Guide
administration because SAS Enterprise Guide needs to access at least one metadata
source, whether it is local or on a network server, in order to access and share metadata
definitions.

If you are using SAS Enterprise Guide only with a local SAS server, you do not need
to install and configure a metadata server. You will be able to access the SAS files and
SAS Enterprise Guide projects on your local machine, but you will not be able to define
libraries or share SAS resources.

You can use SAS Enterprise Guide Explorer to create profiles for multiple metadata
servers, and then select one profile as the active profile. SAS Enterprise Guide then
uses the server that is identified by the active profile as the source for object definitions.
You can change which profile is designated as the active profile, but you cannot share
object definitions between profiles.

Figure 2.1 is an example of a multi-repository configuration that is used with SAS
Enterprise Guide, with a SAS Metadata Repository selected as the active repository.
This specifies that SAS Enterprise Guide uses the selected SAS Metadata Repository
for object definitions.

Figure 2.1 Repository Configuration, Active SAS Metadata Repository

SAS Metadata ~

SAS Enterprise Server #1

Guide user

N——
SAS Metadata ~

Set SAS Metadata Server #2

Server #3 as Active

N——
- ACTIVE ~—

P Server #3
N———

After you set up the profile configuration, you can use the automatic update feature
to make changes to the configuration and apply the changes automatically to all
machines where SAS Enterprise Guide is installed. You first use SAS Enterprise Guide
Explorer to make changes to the configuration, including defining all profiles and
designating the active profile. The new configuration information is then saved to a file
in a network location. When a SAS Enterprise Guide user starts the application, the
configuration file is automatically read and the profile changes are applied.

Figure 2.2 shows how the changes to the profile configuration are applied to SAS
Enterprise Guide through the configuration file.
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Figure 2.2 Profile Changes Applied through Configuration File
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Setting Up SAS Metadata Servers

The metadata definitions on SAS Metadata Servers are used not only by SAS
Enterprise Guide but also by other SAS applications. Using SAS Metadata Servers
enables SAS Enterprise Guide users to access and share libraries and servers with
other applications.

A SAS Metadata Server is installed by the SAS Deployment Wizard during the
installation and configuration of SAS software. Use SAS Management Console to create
repositories on the metadata server that will contain the SAS Enterprise Guide object
definitions. For information about defining SAS Metadata Servers and repositories, see
the SAS Intelligence Platform: System Administration Guide.

Note: The character encoding of the metadata server and the data sets that you use
in SAS Enterprise Guide must be the same. If they do not match, reports that are
produced from the data might contain errors. A

Managing Profiles

About Profile Management

After the metadata servers that you need are defined, you must create and manage
profiles to connect to the servers’ definitions so that SAS Enterprise Guide can access
them. Managing profiles includes these tasks:

O creating new profiles

o specifying the active SAS Workspace Server

0 modifying existing profiles

O setting up automatic updating of profile information

To configure and manage repositories, select File » Manage Profiles. The
Connections dialog box opens.
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Connections

Servers
Updates

bicebill
bicebill 8561 zazdemo

The Connections dialog box contains a list of all the profiles that have been defined
for SAS Enterprise Guide Explorer. The active profile is identified by the active profile

icon (‘ ).

Define a Profile
To connect to a metadata server, you must create a definition for the profile in the
Connections dialog box. To define a profile, follow these steps:

1 Select Profiles from the selection pane and click add. The Create Profile dialog
box opens.
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2 Specify the name and description for the profile.

3 Specify the machine and the port to which the profile connects. If the profile
connects to a local machine, you only have to specify the port number. If you are
using SAS Enterprise Guide in a Citrix environment, you must specify Remote and
the ID of the Citrix server. You must specify Remote even if the server is on the
same machine that you are currently using.

4 Specify how users connect to the machine. If the machine is running Microsoft
Windows, you can select Use Integrated Windows Authentication to specify
that the credentials that are used to log on to the Windows desktop are also used
to connect to the machine. If you do not use Integrated Windows Authentication,
you must specify a user ID and password under which connections are made.

If you are configuring a Citrix environment, specify a valid ID and associated
password for logging on to the Citrix server. This ID will be used only to establish
an administrative connection with the server. Individual SAS Enterprise Guide
users are prompted for their user IDs and passwords.

5 Leave the Authentication Domain field blank unless your organization has set up
a specific authentication domain configuration. If the field is left blank, SAS
Enterprise Guide automatically uses a value of DefaultAuth for the authentication
domain. The authentication domain enables the machine to use resources without
authentication prompts. When a user accesses a resource on the server, the
authorization domain of the resource is compared to the value that is specified for
the profile. If the authorization domains match, the user does not have to enter
credentials to use the resource.

6 Click save to create the profile definition and return to the Connections dialog box.
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Specify an Active Profile

You can specify one profile as the active profile. The active profile connects to the
server that serves as the source for all resource definitions (such as servers and
libraries).

To specify an active profile, select Profiles from the selection pane, select a profile
from the list of defined profiles, and then click set Active. The selected profile is

identified by the active profile icon (‘ ).

Modify a Profile

After a profile has been defined in the Connections dialog box, you can modify the
properties of the profile. To modify a profile, follow these steps:

1 Select Profiles from the selection pane, choose the profile that you want to
change, and then click Modify. The Modify Profile dialog box opens.

1 ' Modify Profile

O

bicebil

[
R |
S

-

| Swe | cocal |

2 Make any needed changes to the profile options, and then click Save to accept the
changes and return to the Connections dialog box.

Delete a Profile

You can use the Connections dialog box to delete a profile. Select Profiles from the
selection pane, choose the profile that you want to remove, and then click Delete.
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Specify the Active Workspace Server

After you have specified the active profile, you must specify the default SAS
Workspace Server that will be used to process SAS requests. You must use SAS
Management Console to define SAS Workspace Servers on the machine to which the
profile connects.

To specify the default server, follow these steps:

1 Select servers from the selection pane.

2 Select Automatically add local SAS server to specify that a workspace server
that runs on the local machine is added to the list of workspace servers on the
remote machine.

3 Use the menu to select a SAS Workspace Server from the list of servers that have
been defined on the active profile’s machine. Use SAS Management Console to
define additional servers if needed.

Configure Profile Updates

Whenever you make changes to the profile configuration, such as changing the
machine to which a profile connects or adding a new profile, you must provide the
changed information to SAS Enterprise Guide users so that they can find the changed
profiles. To avoid having to update SAS Enterprise Guide users manually, you can store
the profile configuration information in a shared location and enable SAS Enterprise
Guide to automatically apply configuration updates.

To set up automatic updating, follow these steps:

1 In SAS Enterprise Guide Explorer, select File » Manage Profiles.

2 In the Connections dialog box, select Updates from the selection pane.

Connections

Profiles
Servers

hretwork \updateshBEMG

3 Select Update configuration automatically if you want SAS Enterprise Guide
Explorer to receive updates to the configuration information. Usually, the
information in SAS Enterprise Guide Explorer and the information in the
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configuration file are the same, but you might want to select this option for testing
purposes.

If you selected the Update configuration automatically check box, use the
Location of update file field to specify a network location that all SAS
Enterprise Guide users can access. When you activate automatic updating, SAS
Enterprise Guide checks this location for automatic updates to the profile
configuration information.

Click check for updates now to test whether SAS Enterprise Guide Explorer
can locate the update information in the specified location.

4 Click close.

Copy the SDSUpdate.xml file from the work directory that you specified when you
first configured the profiles (see “Create a Shared Profile Deployment” on page 13)
to the network location that you specified in the Connections dialog box.

Copy the SDSControl.xml file from the work directory to the network location that
you specified in the Connections dialog box. If you change the location of the
configuration update file, then you must copy the changed SDSControl file to all
machines where SAS Enterprise Guide is installed.

In SAS Enterprise Guide Explorer, select Tools » Customize EG Options. This
opens the Options window. Select the Administration options and click Modify
in the Connections area. The Connections dialog box opens.

= Customize Options

General
Froject Yiews
Project Recovery
Results
Results General
Wiewer
SAS Report
HTML
RTF
FOF
Graph
Stored Process
Data
D ata General
Performance
Guem
OLAP Data
Tasks
Tazks General
Cusztom Code
Output Library
SAS Programs
Secur

8 Select Updates from the selection pane and specify the location of the

configuration update file that you specified in the Connections dialog box from SAS



Setting Up Profiles /A Create a Shared Profile Deployment 13

Enterprise Guide Explorer. Select Update configuration automatically. Click
OK to close the Connections dialog box.

9 In the Options window, click save to save the options to EGOptions.xml.

10 Include the EGOptions.xml file in the SAS Enterprise Guide installation package
to automatically apply the option to all machines where SAS Enterprise Guide is
installed. If you already have SAS Enterprise Guide installed, you can distribute
the EGOptions.xml file to the machines where SAS Enterprise Guide is installed
in order to change the default SAS Enterprise Guide options.

Create a Shared Profile Deployment

After you define profiles, you can configure the deployment so that it is shared by
SAS Enterprise Guide users. Whenever you make changes to the profile configuration,
such as changing the machine that is specified in a profile or adding a new profile, you
must provide the changed information to SAS Enterprise Guide users so that they can
find the changed profiles. By storing the profile configuration information in a shared
location and enabling SAS Enterprise Guide to automatically apply configuration
updates, you can avoid manually updating SAS Enterprise Guide users.

To configure profile deployment in SAS Enterprise Guide Explorer, follow these steps:

1 Select Tools » Profile Deployment Wizard.

The Profile Deployment Wizard starts. Page 1 lists the tasks that the wizard
will perform. Click Next.

2 Page 2 of the wizard lists the name and type of the active profile. To change the
active profile or to define a new profile, click Configure Profiles. Click Next.

3 Page 3 enables you to test the connection to all of the machines that are defined in
profiles. When you click Begin Test, the application attempts to establish a
connection to each of the defined machines. The Status column indicates whether
the connection was successful. When you have finished the test, click Next.

x
3 of6  “erifythe configuration by connecting to each profile. Ssas

MHame I td achine I Puart I Status I
BIC hicebill 8561 DK

BIC2 bicebill 8561 ]

tdairn Bl gerver 1234, mycarp.conm 3861 Failed

Beain Test |

<Back |'| Mewxt> Flrilri Cancel Help
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4 Page 4 enables you to specify the location of the shared configuration update file.
By using automatic updating, you can make changes to the profile configuration in
SAS Enterprise Guide Explorer, and those changes will automatically be sent to
all SAS Enterprise Guide users.

I Profile Deployment Wizard

4 off Specify location far shared update file. S%S

Snetwork\updateshBBMG

-

If you specified the location of the configuration update file in the Updates area
in the Connections dialog box, then the value that you specified is listed in this
field. If you did not specify the location, then enter a network location that all SAS
Enterprise Guide users can access.

5 Click Next.

6 Specify the location where SAS Enterprise Guide Explorer stores the profile
configuration files.
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I Profile Deployment Wizard x|
5 off Specify location ta write the generated configuration files. Ssas

The following files will be generated and written to the specified location:

SDSUpdate.xml  Profile configuration data without users and pazswards.

SDSControl.xml  Control data used for the update process.

Location to wite configuration files:

It:\EuntmI\FiepnsEontrol Browse... |

<Back |'| Mext: Firiek Cancel Help |

The SDSUpdate.xml file contains the configuration information that is read by
SAS Enterprise Guide to provide automatic updating. When the configuration is
complete, you should move this file to the location that you specified in step 4. The
SDSControl.xml file is distributed with the SAS Enterprise Guide installation
package in your organization. This file specifies the location of the automatic
update file.

Specify a location on your local drive for these files. When the configuration
process is complete, copy the files to the appropriate location.

7 Click Next.

8 Specify whether you want to view the readme file. Then click Finish to create the
profile configuration files.

9 Copy the SDSUpdate.xml file from the work directory that you specified when you
first configured the profiles to the network location that you specified in the
Connections dialog box.

10 Copy the SDSControl.xml file from the work directory to the network location for
the SAS Enterprise Guide installation image. If you change the location of the
configuration update file, you must copy the changed SDSControl file to all
machines where SAS Enterprise Guide is installed.

Creating Desktop Shortcuts for Different Profiles

After you have created profiles, you can associate a profile with a shortcut on the
Windows desktop. This capability enables you to start SAS Enterprise Guide with a
specific profile by clicking on a specific shortcut. You can also start SAS Enterprise
Guide without a profile by using a desktop shortcut.

To associate a profile with a desktop shortcut, follow these steps:

1 Create a shortcut for the file SEGuide.exe. By default, it will be in the directory
C:\Program Files\SAS\EnterpriseGuide\4.2.



16 Creating Desktop Shortcuts for Different Profiles A Chapter 2

2 Right-click on the shortcut that you created and select Properties.

3 To start SAS Enterprise Guide by using a specific profile, add
/profile:<profile name> at the end of the string in the Target box. You must
include a space before /profile. If the profile name includes spaces, you must
enclose the name in quotation marks:

‘*C:\Program Files\SAS\EnterpriseGuide\4.2\SEGuide.exe'’'’ /profile:’’SAS Metadata’’

To start SAS Enterprise Guide without a profile, add /noprofile at the end of the
string in the Target box. You must include a space before /noprofile:

‘+C:\Program Files\SAS\EnterpriseGuide\4.2\SEGuide.exe’’ /noprofile

4 Click oK to close the Properties dialog box.

5 You can now rename and move the shortcut to the desktop.
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Preparing a Setup Image for Users in a Network Environment

Setting up SAS Enterprise Guide includes giving users access to a setup image of
SAS Enterprise Guide. Users must access the setup image in order to install the SAS
Enterprise Guide software on their local machines. In a network environment, you
create a setup image on a server. Note that the setup procedure includes identifying the
profile and associated metadata server.

In a network environment you can create several profiles for several servers, each
one for different groups of users. This is the most complex way to use metadata servers,
and it is also the most powerful. If you create several metadata servers, then you will
need to configure a different setup image for each group of users so that each group will
access the correct profile at start-up.

To create a setup image for users in a network environment, follow these steps:

1 If you have not already done so, choose a location for the setup image. The
location should be on a server that all users can access. Using Windows Explorer
or another file manager, copy the installation files (from the installation CD or
from another location) to the chosen location.

2 Create a customized set of defaults for SAS Enterprise Guide installations, which
are automatically applied when users install SAS Enterprise Guide. The defaults
are read from the EGOptions.xml file (if present) and the options.ini file when the
installation is performed. If you do not create an EGOptions.xml file, SAS
Enterprise Guide will use the default values that are set by SAS.

To create the EGOptions.xml file, open the Enterprise Guide Options window by
selecting Tools » Customize EG Options from SAS Enterprise Guide Explorer.
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Specify the default values for SAS Enterprise Guide installations by selecting
each category and setting the displayed options. Position the mouse pointer over
an option in order to display a brief description of that option at the bottom of the
window.

3 After you set the default values, click save or save As. In the Save window,
specify a filename of EGOptions.xml. After you create the file, copy it to the
location for the setup image.

4 Ensure that the profile information for this set of users is in a location where users
can access it. (It does not need to be in the same location as the installation files.)

5 Copy the SDSControl.xml file from the work directory to the SAS Enterprise
Guide setup directory and to the <shared_files>\SAS Directory Services location.
This file contains the central profile information. The <shared_files> location is
typically ¢:\Program Files\SAS\Shared Files, but the location might differ
depending on your installation.

6 Copy the SAS Enterprise Guide application setup directory to a network drive that
users can access in order to run SETUP.EXE, which is the program that installs a
copy of the setup image on users’ local machines. Add the SDSControl.xml file to
the directory where SETUP.EXE resides. You can provide a link from a Web site to
the directory for easy access.
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Understanding Metadata Objects

A metadata object is a definition in metadata of a SAS resource that is used by SAS
applications. Definitions for servers, libraries, and users are all examples of metadata
objects. After an object is defined on a metadata server, the object is then available for
use by any SAS application that has access to the server, which enables applications to
use a consistent set of resources throughout your organization.

Metadata objects are defined and managed by SAS Management Console, which is
the primary application for administering metadata. However, you can also use SAS
Enterprise Guide Explorer to manage library definitions. The following objects are
managed by SAS Management Console and used in a SAS Enterprise Guide

environment:

Servers includes SAS Application Servers, SAS spawners, database servers,
OLAP servers, WebDAV servers

Libraries includes SAS libraries and database libraries

Users users who have access to the resources that are defined in metadata
(note that the Login Manager enables the current SAS Enterprise
Guide Explorer user to manage some parts of their login information)

Groups users grouped by job function, access level, or other criteria

Security controls that specify which users and groups can access resources

settings that are defined in metadata and how users and groups can use

those resources

Other metadata objects might be defined by SAS Management Console plug-ins or by
other SAS applications such as SAS Data Integration Studio or SAS Information Map
Studio.
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For information about creating these objects, see the online Help for SAS
Management Console or the SAS Intelligence Platform administration guides that are
listed in Appendix 1, “Recommended Reading,” on page 51.

Viewing Objects in SAS Enterprise Guide Explorer

You view objects in SAS Enterprise Guide Explorer the same way that you view
objects in the Windows Explorer. Expand a server or folder to view the contained objects.

=
File ‘iew Edit Tools Help
’4\ ¥-|\|l |.| U
B Servers Name | Description | Libref | Location -l
krz_cred_db2 test remaove wser credentials for DEMS DEZ2 /BIP Tree/Keith
kre_cred_oracle test remove uzer credentialz for DEMS ORACLE /BIP Tree/Keith
krc_cred_tera test remove user credentials for dbms TERA /BIP Tree/Keith
kretest show library assigned via EG KRCTEST #Shared Datadret
Large Diata LDATA #Shared Data/Lar
MAPS MAPS
Mark123 MARK123
markdb MARKDE #Mew Folder
g#:::g t:;s ervers marktsts MDE53 Mew Falder
il Stored Process Servers mh_demo DEMO #Shared Data/mh_
.....éligl Actions mh_mdb MDE #5hared Datasmh_
[]"'Cl_i 545 Folders rah_oricn ORION #Shared Datasmb_
mh_sls *DB #Shared Datasmb_
mho_orion ORIOM #Shared Data/mhc
MIKE MIKE fShared Data/MIK,
MLEAI temporany test libramy TEST1 #Shared Data/MLE
tLEMetalnly temporary test ibrany TESTZ2 #Shared DataLE
MLEMetaDnlalIPerm MLE2 #Shared DataMLE
MSACCESS Microsoft Access 2002 Morthwind database [Mor..  MSACCESS  /Shared Data/M5s
MSEXCEL Microzoft Excel 5olvzamp.ls sample file MSEXCEL #Shared Data/MSE
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If you are accessing objects that reside on a specific SAS server, then you might be
prompted to enter a user ID and password.

You can customize your session further by selecting View from the menu. From the
menu you can change how the objects are displayed in the SAS Enterprise Guide
Explorer window.

Managing SAS Servers

SAS servers are network computers on which SAS is installed. SAS servers enable
multiple clients to access and use SAS libraries (and members of the libraries)
concurrently. A SAS server for SAS Enterprise Guide can run in a Windows, z/OS, or
UNIX operating environment. You must use SAS Management Console to define
servers before you can define libraries, either with SAS Management Console or SAS
Enteprise Guide Explorer. For information about defining servers, see the Help for SAS
Management Console.
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Managing Libraries

Ahout Libraries

Libraries are collections of files that are stored on a server and accessed from SAS
Enterprise Guide. Libraries give SAS Enterprise Guide users convenient access to their
data on servers. When you add a metadata definition for a library through SAS
Enterprise Guide Explorer or SAS Management Console, you make the metadata
definition available to all the network SAS Enterprise Guide installations that have
access to a specific metadata repository as well as all other applications that use the
repository. The metadata definition for a library includes the path, engine, and other
options for the library. The metadata definition corresponds to the information that is
specified in a LIBNAME statement.

Table definitions specify the tables and columns that are available within a library.
You can create table definitions by using one of the following functions:

O using the Update Library Metadata function in SAS Enterprise Guide
O using the Register Tables function in SAS Management Console

O running the METALIB procedure in a SAS session (which synchronizes metadata
with the physical contents of a library)

O using SAS Data Integration Studio to build a data warehouse

You can include authorization settings for both library and table definitions,
specifying which libraries and tables a user can access and whether the user can
change the contents of a library.

Note: Before you add a library, you must use SAS Management Console to add the
server on which the library resides. A

To define a library:
1 Define the library’s path on the server platform.
2 Specify the SAS engine that is identified with the library.

3 Enter any associated options that you can specify in a LIBNAME statement.
LIBNAME options work like the commands in an AUTOEXEC.BAT file. The
LIBNAME options are stored on the client and then executed when a SAS
Enterprise Guide application connects to the specified SAS server. For more
information about SAS libraries, LIBNAME statements, and LIBNAME options,
see SAS Language Reference: Dictionary.

Understanding the Metadata LIBNAME Engine

To understand how SAS Enteprise Guide assigns and accesses libraries, it is helpful
to understand the metadata LIBNAME engine. The engine, also called the META
engine, enables you to use a LIBNAME statement to reference a metadata definition for
a library, rather than specifying the physical location of the library’s tables. By default,
the META engine provides read-only access to a library, which prevents the library
contents from being different from the library metadata.

If you use the METAOUT=DATA option in the LIBNAME statement, the META
engine can access tables that are not defined in metadata but that exist in the physical
library. This option enables you to add and modify tables in the library. However, any
metadata authorization settings that have been applied to tables or columns in the
library are enforced. If a SAS program changes the contents of a library that uses the
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METAOUT=DATA option, you must synchronize the physical data and the metadata.
To synchronize the data, you can use the Register Tables function in SAS Management
Console, the METALIB procedure, or the Update Library Metadata task in SAS
Enterprise Guide.

Adding a Library

To add a library, select File » New » Library and follow the prompts on each page of
the Library Wizard. Depending on the options that you select in the wizard, the number
of pages in the wizard and the page on which a specific option appears might change.

Use the following information when completing the wizard:

0 On page 1 of the wizard, you must specify a name for the library. The name can be
up to eight characters long and must not be duplicated on any server on which you
are creating the library. The wizard automatically enters the name in uppercase
characters.

0 On page 2 of the wizard, you must specify how the library is assigned. You must
choose to assign the library by using one of the following:

SAS Enterprise  specifies that SAS Enterprise Guide uses the metadata that is
Guide supplied in the wizard to assign the library by using the native
engine. No table or column metadata is used.

SAS Server specifies that the library is assigned in an autoexec statement
or through the METAAUTOINIT system option. SAS
Enterprise Guide does not use the metadata that you specify
for the library, but assumes that the library is already assigned.

Metadata specifies that SAS Enterprise Guide assigns the library by
Library Engine  using the META engine.

If show only tables with metadata definitions is
checked, then only tables that have metadata definitions
appear when the library is selected. When this option is
selected, the library is always read-only. This option is
equivalent to the default behavior of the META engine.

If the check box is not selected, then all tables in the library
will appear (even if you deny ReadMetadata permission for a
table or the table is not registered in the metadata repository).
Permissions are enforced if a user tries to open a restricted
table. In this mode, the library is not read-only. This option is
equivalent to the METAOUT=DATA option.

0 On page 4 of the wizard, you must specify the engine type for the library (file
system, database system, or WebDAV) and specific information for the engine type
that you select. If you are defining a file system or database system library, you
must choose an engine. Select the SAS engine with which the data was created.
For more information about engines, see the SAS documentation for your
operating environment. See also the chapter that corresponds to your database
management system in SAS/ACCESS for Relational Databases: Reference.

0 Also on page 4 of the wizard, you might have to specify the physical path where
the library resides on the server. Depending on the value of the Engine Type field,
Path might not be present. You can use the following wildcards in the Path field:

<userid> substitutes a Windows user ID. For example, if a user logs on
as ebeacon, then \\librarypath\<userid> becomes
\\librarypath\ebeacon.
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<sample> substitutes the SAS Enterprise Guide sample directory. For
example, if you installed using the default directories,
<sample>\data becomes C:\Program Files\SAS\Enterprise
Guide 3.0\Sample\data. If, however, another user installed
in D: \EC, then <sample>\data becomes D: \EC\Sample\data.

<serveruser> substitutes the server logon user ID.
<serverpassword> substitutes the server logon password.
<libraryuser> substitutes the library logon user ID.
<librarypassword> substitutes the library logon password.

Note: These wildcards might not work with client applications other than SAS
Enterprise Guide and the SAS Add-In for Microsoft Office. A

0 On page 5 of the wizard, you can specify library options and values. If wildcards
are valid in the Path field, then you can also use them in the Options field. Avoid
using prompting options such as DBPROMPT=YES. For additional options, see
the chapter that corresponds to your database management system in
SAS/ACCESS for Relational Databases: Reference.

0 On page 6 of the wizard, you must select the folder to which the library belongs. If
you do not select a folder, the library is automatically stored in the Shared Data
folder.

o Page 7 of the server lets you test the library definition on each server. If the
library name or libref is not unique on all servers, the conflict is listed in the
Status column.

After you complete the wizard, the library is created and then displayed in the
viewer under the client libraries for the specified servers.

Creating an Qutput Library

By default, SAS Enterprise Guide stores output data in the Sasuser, Work, or Egtask
library, or a user-created output library on the SAS server. You can select Tools »
Options » Output Library to change the default output library. For example, you
might want all output to go to a central library that all users can access. In addition,
Sasuser is a temporary location on z/OS and some UNIX systems, so output needs to be
directed to a different location in order to be saved permanently.

To define an output library, you can follow either one of these strategies:

0 Use SAS Management Console to define the library. Select bata Library
Manager, and then select New Library. Choose Pre-assigned Library as the
library type to ensure that the library is assigned whenever the server starts.
Make sure that the library is defined on all servers that will be used with SAS
Enterprise Guide.

o Use SAS Management Console to add the LIBNAME statement for the library to
all server definitions that are used by SAS Enterprise Guide. Include the
statement in the SAS startup statements field in the New Server wizard (for

new servers) or in the Properties window (for servers that have already been
defined).

Assigning Libraries

When you view a SAS server in SAS Enterprise Guide or SAS Enterprise Guide
Explorer, you see a list of libraries on the selected server. The list includes both
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libraries that are assigned (identified with a yellow icon) and libraries that are
unassigned (identified with a white icon).
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Assigned libraries are libraries that are pre-assigned or assigned in an autoexec
program. Unassigned libraries are libraries that have been defined in metadata but
have not yet been assigned or accessed. To assign an unassigned library, right-click on
the library and select Assign from the pop-up menu. If the library definition was
created by SAS Enterprise Guide Explorer, the library is assigned using the method
that was specified in the library definition. Otherwise, the library is assigned using the
META engine in its default mode, which means that the library is read-only. The
library contents also match the metadata definition (so physical tables that are not
defined in metadata are not displayed), and the tables and columns that are accessible
depend on the authorization settings.

Updating Library Properties
Properties for libraries include information such as names, pathnames, and
LIBNAME options. To view or update this information:
1 Select a server, and then locate the library whose properties you want to change.
2 Select the library, and then select Properties from the pop-up menu.

3 Select the item in the selection pane that corresponds to the information that you
want to update. For information about each field, see “Adding a Library” on page
22.

Managing Logins

The Login Manager enables you to manage your login information for your user
definition. You can create or modify a user ID and corresponding password and
associate the login with an authentication domain. To work with login information,
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select File » Manage Logins. The Login Manager window displays your user name
and all defined logins for your user.

o Login Manager O] =]
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Click Add to add a new login, or select a login and click Modify to change an existing
login. Either button displays the Edit Login window.

3 Edit Login

Specify the user ID and password (if needed) and select the authentication domain
that is associated with the login. The menu contains all authentication domains that
are currently defined. Use SAS Management Console to add authentication domains.
When you click 0K, the metadata for your user object is modified. The information that
you can modify in the Login Manager corresponds to the information on the Accounts
tab of the Properties window for a user definition in SAS Management Console.
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Migrating from SAS Enterprise Guide 4.1

If you are migrating from SAS Enterprise Guide 4.1, the migration process has two
parts—migrating metadata and migrating SAS Enterprise Guide projects. Because
metadata contains definitions for the objects that projects are built on, you must first
migrate metadata repositories and definitions. If your installation stored metadata in a
SAS Metadata Repository, you must migrate the repository and the definitions to a SAS
9.2 Metadata Repository. This step is part of the process of migration to SAS 9.2. For
information about the migration process, see the SAS Intelligence Platform: 9.1.3 to 9.2
Migration Guide. If your installation stored metadata definitions in a SAS Enterprise
Guide repository, the definitions must be re-created in a SAS 9.2 Metadata Repository,
as detailed in “Migrating from a SAS Enterprise Guide Repository” on page 28.

After you have migrated or converted metadata definitions, you must migrate your
SAS Enterprise Guide projects. To migrate a project, you must convert the project to
the format that is required by SAS Enterprise Guide 4.2 and change any references to
metadata objects that have been renamed or moved. When you open a project in SAS
Enterprise Guide 4.2, the project is automatically converted to the correct format.
However, you must manually change the references for each changed metadata object in
the project. If your organization has a large number of projects to migrate, migrating
them one at a time is inefficient and can lead to errors in metadata references. A utility
is included with SAS Enterprise Guide 4.2 to enable you to migrate groups of projects
and documents to the correct format and to make global changes to metadata
references. For more information, see “Using the Migration Wizard” on page 28.

Access to SAS Enterprise Guide 4.2 tasks is controlled through roles. If you enabled
SAS Enterprise Guide 4.1 tasks based on user groups, you must define roles and specify
role-based access controls to re-create your previous configuration. For more
information, see Chapter 6, “Administering Role-Based Settings,” on page 33.
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Migrating from a SAS Enterprise Guide Repository

In earlier versions of SAS Enterprise Guide, metadata was stored in a SAS
Enterprise Guide repository (SAS Enterprise Guide 4.1 supported both SAS Enterprise
Guide repositories and SAS Metadata Repositories). Although some objects (such as
servers, libraries, and users) that were defined in SAS Enterprise Guide repositories
are also defined in SAS Metadata Repositories, the repositories use very different
metadata models. As a result, it is not possible to automatically migrate metadata
definitions between the two types of repositories.

Use SAS Enterprise Guide Explorer 4.1 or earlier to examine the definitions for each
metadata object (except for binders) in the SAS Enterprise Guide repository, then
record the definition information. After your SAS Metadata Server has been installed
and configured, use SAS Management Console to create new definitions for serves,
libraries, users, and groups. You can also use SAS Enterprise Guide Explorer to create
definitions for libraries.

Using the Migration Wizard

Overview of the Wizard

The Migration Wizard enables you to migrate multiple projects to the SAS Enterprise
Guide 4.2 format at one time. If you have the SAS Add-In 4.2 for Microsoft Office
installed, the wizard also migrates files that are used with the SAS Add-In 2.1 for
Microsoft Office, such as Microsoft Word files or Microsoft Excel files. You can use the
wizard to identify the projects and documents that you want to migrate and specify new
locations for objects in the migrated files. The wizard converts the projects and
documents to the correct format and makes global changes to the changed object
references.

In addition, you can use mapping files and a migration record file to supply
information to the wizard.

Using the Wizard

To run the Migration Wizard, follow these steps:

1 Create all required metadata objects in metadata. If you need to create new
metadata definitions for objects such as servers or libraries, you should create
these definitions before you run the migration wizard. The wizard does not create
any metadata definitions. If you run the wizard before you create new definitions,
you will receive an error whenever you open a project that refers to a metadata
object that has not been defined.

2 Navigate to the SAS Enterprise Guide installation directory (the default location is
C:\Program Files\SAS\EnterpriseGuide\4.2). Start the wizard by
double-clicking on MigrationWizard.exe or issuing the command from the
command line.

Note: You must close all Microsoft Office applications before you run the
Migration Wizard. a

3 Follow the procedure in the wizard:
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a Page 1 provides an introduction to the wizard.

b On page 2, verify that the active connection is correct. Click Modify to display
the Connections dialog box, where you can change the active profile or create a
new profile.

If the selected connection contains information about SAS folders that have
been moved or renamed as part of the SAS installation and migration process,
click Import. The information that is imported from your connection is used by
the Migration Wizard to automatically remap the location of SAS folders.

¢ On page 3, select the files that you want to migrate. You can select files from
local directories, servers, and SAS folders. Use the arrow to move files
(preserving the tree structure) to the Selected Files area. Selecting a node
such as a folder or a server automatically selects all files under that node.
Expand the Local, Server, or SAS Folders nodes to locate individual files or
directories. Use the Show field to select the type of files that are displayed. To
access files on a remote machine, click Add Location. The Windows Add
Network Drive dialog box is displayed, which enables you to map a network
drive to a remote location.

The Migration Wizard processes these types of files:

o SAS Enterprise Guide Projects (*.egp)
SAS Web Report Studio Reports
Microsoft Excel files (*.xls)

Microsoft Word documents (*.doc)

o

i

i

O Microsoft PowerPoint presentations (*.ppt)

The SAS Add-In for Microsoft Office must be installed in order to migrate
Microsoft Excel files and Microsoft PowerPoint presentations.

d Page 4 provides an overview of the process of identifying object references that
might need to be changed. When you click Next, the parsing process begins.
The status of the process is indicated by a progress bar.

e If the wizard finds a mapping file, it will ask whether you want to use it. A
mapping file is an XML document that specifies correlations between old
locations and new locations for objects. A mapping file enables you to specify
the object mappings once and then have those mappings automatically applied
in the wizard. By default, mapping files are stored in \\My
Documents\Application Data\SAS\BI Clients\4.2\Migration.

f Page 5 lists all of the metadata objects that are referenced in the selected files,
identifies their type, and provides the currently specified location of the object.
To change the mapping for an object, click in the New Mapping column for the
object, click the button in the field to open the Change Resource dialog box, and
enter a new location or browse to the new location. You can also choose to
automatically apply the new location to all objects in the migration list that use
the current value. No changes are made until the wizard completes.



30

Mapping File Format A Chapter 5

. Migration Wizard for SAS Enterprise Guide a x|
b ofB Set mapping infarmation Ssas
This table lists the object references in the elected files, along with the current location [or mapping) for each object. [F an object
reference hag changed or moved, click. the New Mapping column for the object and type the new location or click the buttan in the field
to select a location.

Show: Al references j
Object Mame | Object Typs | Current tapping Mew Mapping
SASMain Server SaS5Main 5 a5t i - P,
Local Server Local
S&SUSER Library Local:SASUSER [S&SUSER)
M5 8.2 Ported Image wit... | Server WS 8.2 Ported Image with DEZ ... | M5 [HFS]
SASHELP Library WS 8.2 Ported Image with DBZ2 ... | MYS [HF5):SASHELP [SASHELP)
SASUSER Library WS 8.2 Ported Image with DBZ2 ... | MYS [HFS):545U5SER [SASUSER)
SAaSUSER Library SASMain SASUSER [SASUSER) | SASMain - Iwia:SASUSER [SASU..
WORK Library SASMain'wWOREK [WORK) SASMain - IwaWORE WORK)

Back || New Frish Carcel Help

On page 6, you can specify the name of the migration record file, which contains
all of the settings that are specified in the wizard. If you specify the migration
record file as a parameter when you run the Migration Wizard from the
command line, the wizard will be initialized with all of the settings that you
used when the file was created. You can also specify the location of a log file and
specify whether files will be backed up before conversion.By default, migrated
files are backed up and the original files are overwritten.

You can specify that the migration process attempts to verify that the new
resources exist and note the status in the log. The changes are applied whether
or not the resources are verified. In order to accurately verify the remappings,
you must have Read permissions in metadata for objects such as servers and
libraries and operating system Read permissions for file locations. Click Finish
to migrate the selected files.

Mapping File Format

The following is the format of the mapping file that is used to identify correlations
between old and new locations for metadata objects. This file must be named
MappingInformation.xml and stored in \\My Documents\Application Data\SAS\BI
Clients\4.2\Migration. Include as many <MappedItem> blocks as needed to change
the mapping for all affected objects. The format of MappingInformation.xml is as

follows:

<MappingInformation>
<MappedItem>
<ReferenceName>server name

<ReferenceID>server ID

<ReferenceType>Server

<CurrentMapping>old server definition

<NewMapping>new server definition
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<MappedItem>
<ReferenceName>library name
<ReferencelID>library ID
<ReferenceType>LIBRARY
<CurrentMapping>old library definition
<NewMapping>new library definition

<MappedItem>
<ReferenceName>stored process name
<ReferenceID>stored process ID
<ReferenceType>SAS.EG.ProjectElements.StoredProcess
<CurrentMapping>old stored process definition
<NewMapping>new stored process definition

<MappedItem>
<ReferenceName>external file name
<ReferencelID>external file ID
<ReferenceType>SAS.EG.ProjectElements.ExternalFile
<CurrentMapping>old external file definition
<NewMapping>new extenal file definition

<MappedItem>
<ReferenceName>information map
<ReferencelID>information map ID
<ReferenceType>SAS.EG.ProjectElements.InformationMap
<CurrentMapping>old information map definition
<NewMapping>new information map definition

<MappedItem>
<ReferenceName>0OLAP catalog name
<ReferenceID>OLAP catalog ID
<ReferenceType>0OLAPCATALOG
<CurrentMapping>old catalog definition
<NewMapping>new catalog definition
<OLAPCatalogName>old OLAP catalog name
<OLAPServerName>old OLAP server name
<OlapServerType>old OLAP server type
<OlapProviderName>old OLAP provider
<OlapLoginMode>old login mode
<OlapExtProperties>extended properties for connecting to the OLAP
<OlapHostName>old host name
<OlapPort>old port
<NewOLAPCatalogName>new OLAP catalog name
<NewOLAPServerName>new OLAP server name
<NewOlapServerType>new OLAP server type
<NewOlapProviderName>new OLAP provider
<NewOlapLoginMode>new login mode
<NewOlapExtProperties>new extended properties for connecting to
the OLAP server
<NewOlapHostName>new host name
<NewOlapPort>new port

<MappedItem>
<ReferenceName>0OLAP server name

server

31
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<ReferenceID>OLAP server ID

<ReferenceType>0OLAPSERVER

<CurrentMapping>old server definition

<NewMapping>new server definition

<OLAPServerName>old OLAP server name

<OlapServerType>old OLAP server type

<OlapProviderName>old OLAP provider

<OlapLoginMode>old login mode

<OlapExtProperties>extended properties for connecting to the
OLAP server

<OlapHostName>old host name

<OlapPort>old port

<NewOLAPServerName>new OLAP server name
<NewOlapServerType>new OLAP server type
<NewOlapProviderName>new OLAP provider
<NewOlapLoginMode>new login mode

<NewOlapExtProperties>new extended properties for connecting to
the OLAP server

<NewOlapHostName>new host name

<NewOlapPort>new port

(repeat as needed for all objects)
<MappingInformation>

Initializing the Wizard by Using a Migration Record File

You can create a migration record file when you run the Migration Wizard. This file
contains a record of all of the information that is provided in the wizard. If you start
the Migration Wizard from the command line and specify the migration record file as a
parameter, the wizard will be initialized with the same settings that you used when the
file was created.

To create a migration record file, specify a name for the file on the last page of the
Migration Wizard.

To run the wizard and specify the migration record file, issue this command from a
command line:

MigrationWizard <migration record file>
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Understanding Role-Based Settings

Because SAS Enterprise Guide and the SAS Add-In for Microsoft Office are used by a
wide variety of users and groups within an organization, administrators must be able to
control the resources and actions that users can access. For example, an organization
might want to allow some users to run reports, but not to modify them. The
organization might want to prevent SAS Enterprise Guide users from saving files to
their local hard drives. Or the organization might want to display only needed SAS
Enterprise Guide tasks, project settings, tools, and help, and hide the rest. SAS
Enterprise Guide and the SAS Add-In for Microsoft Office enable you to control the
actions and tasks that are available to users through roles and role-based settings.

A role manages the availability of application features, called capabilities. For SAS
Enterprise Guide and the SAS Add-In for Microsoft Office, the capabilities include how
files are opened and saved, the options settings that are visible, and which project
settings might be modified. Members are assigned to the roles, based on their activities
and responsibilities in your organization. SAS Enterprise Guide tasks are also
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considered to be capabilities, so you can present a variety of views of the resources and
actions that are available to users through their role membership.

Creating Roles and Modifying Role Settings

To use role-based settings, you must determine the roles that you need, select
capabilities for each role, and assign users or groups to roles. Several main
administrative roles are defined by default, and SAS Enterprise Guide and the SAS
Add-In for Microsoft Office also define several roles that are specific to the application.
If the provided roles and the capabilities in each role match the activities and
responsibilities in your organization, you only need to assign users to roles. To assign
users to a role, use SAS Management Console to view the Properties window for a role.
On the Members tab, select the users that should be assigned to the role.

If the provided roles do not match the division of responsibilities in your
organization, you must create a custom role:

1 In SAS Management Console, select the User Manager plug-in.

2 Select New » Role to open the New Role dialog box.

3 Use the Members tab to specify which users and groups are assigned to the role.

4 Use the capabilities tab to assign the SAS Enterprise Guide and the SAS
Add-In for Microsoft Office capabilities and specify tasks to the role.

To modify the capabilities for a role, select the role in the User Manager in SAS
Management Console, and then select Properties. Select the capabilities tab and
choose the capabilities that are assigned to the role.
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For more information about working with roles, see SAS Management Console:
Guide to Users and Permissions.

Capability Listings

The following sections list all of the capabilities that are provided for use with SAS
Enterprise Guide. The roles that are listed for each capability are those that are
installed with SAS Enterprise Guide. The organization that is used in this topic
matches the organization of capabilities in SAS Management Console.

Open or Import Capabilities

Open Files from Local Computer

Roles

Description

OLAP, Analysis, Programming, Advanced

If granted, the user can open or import a file from the local file
system. If not granted, the Open File dialog box does not allow the
user to navigate to the local system, and the user cannot copy and
paste or drag from the local file system. This capability does not
provide a substitute for system security.

Open Cube from OLAP Server

Roles

Description

OLAP, Analysis, Programming, Advanced

If granted, the user can open an OLAP cube source in a project. If
not granted, all menus and the tree view should not allow the user
to open an OLAP cube or navigate to an OLAP server.

Open Files from SAS Server

Roles

Description

Programming, Advanced

If granted, the user can open or import a file from the file system of
a SAS server. If not granted, the Open File dialog box does not allow
the user to navigate to the file system of the SAS server. The SAS
server file system tree is also removed from the SAS Enterprise
Guide tree view. This capability does not provide a substitute for
system security.

Open Data from Exchange

Roles

Description

Advanced

If granted, the user can open a source from Microsoft Exchange into
a project. If not granted, the menus and process flow diagram do not
allow a Microsoft Exchange file to be opened.

Open Data from OLEDB

Roles

Advanced
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Description If granted, the user can open a source from an installed OLE DB
provider. If not granted, the menus and process flow diagram do not
allow an OLE DB source to be opened.

Open Data from ODBC
Roles Advanced

Description If granted, the user can open a source by using an ODBC driver. If
not granted, the menus and process flow diagram do not allow an
ODBC source to be opened.

Open Information Map
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Open Information Map task.

Import Data
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Import Data task.

Save or Distribute Capabilities

Save Files to Local Computer
Roles OLAP, Analysis, Programming, Advanced

Description If granted, the user can save a file or project to the local file system.
If not granted, the Save File dialog box does not allow the user to
navigate to the local file system, and the user cannot copy and paste
or drag to the local file system. This capability does not provide a
substitute for system security.

Save Files to SAS Servers
Roles OLAP, Analysis, Programming, Advanced

Description If granted, the user can save files or projects to the file system of
SAS servers. If not granted, the Save File dialog box does not allow
the user to navigate to the file system of the SAS server. The SAS
server file system tree is also removed from the SAS Enterprise
Guide tree view. This capability does not provide a substitute for
system security.

Modify Output Data Location in SAS Tasks

Roles Analysis, Programming, Advanced

Description If granted, the user can change the output location for tasks and
wizards. If not granted, all controls that allow the user to change
the output location are removed from tasks and wizards.
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Copy and Paste SAS Server Content
Roles Analysis, Programming, Advanced

Description If granted, the user can copy and paste from SAS server files and
libraries. If not granted, the applicable menu items are removed and
the drag-and-drop feature is disabled. This capability does not
provide a substitute for system security.

Publish to Distribution Channel
Roles Advanced

Description If granted, the user can create or modify a publish wizard to
distribute content to a distribution channel. If not granted, the
Publish menu item is removed, and the user is not allowed to make
any changes to a publish wizard step.

Send Content to E-mail Recipient
Roles OLAP, Analysis, Programming, Advanced

Description If granted, the user can create or modify a wizard to distribute files
by using e-mail. If not granted, the menu items E-mail Recipient
and E-Mail Recipient as a Step in Project are removed. The
user is not allowed to make any changes in existing e-mail
distribution steps.

Content Capabilities

Create or Modify Advanced Query
Roles Analysis, Programming, Advanced

Description If granted, the user can create and modify advanced queries in
projects. If not granted, the Query Builder menu item is removed,
and the user is not allowed to make any changes to existing
advanced queries.

Create or Modify Data Join in Advanced Query
Roles Analysis, Programming, Advanced

Description The user can create or modify a table join in an advanced query. If
not granted, the Add Table and Join menu items are removed.

Create or Modify SAS Program
Roles Programming, Advanced

Description If granted, the user can create and modify code nodes in projects. If
not granted, the user is allowed to run the code in an existing
project, but might not be able to make changes to the code. Users
are also not allowed to open existing SAS programs in SAS
Enterprise Guide projects.
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Add or Modify Custom Code to SAS Task

Roles Programming, Advanced

Description If granted, the user can create or modify custom code that runs in a
SAS Enterprise Guide task. If not granted, the user is not allowed
to add or modify code in a task.

Create or Modify SAS Stored Process
Roles Programming, Advanced

Description If granted, the user can create or modify stored processes in projects.
If not granted, the create Stored Process and Write TaskCode
to Stored Process menu items are removed. The user is not
allowed to make any changes to existing stored processes.

Options Capabilities

Modify SAS Server Reference in Project or Document
Roles Analysis, Programming, Advanced

Description If granted, the user can change the internal server reference for all
projects that run on the server. If not granted, the Select Server
menu item is removed.

Modify Security Options
Roles Advanced

Description If granted, the user can change the security options for projects. If
not granted, the user can view the security options, but cannot
change them.

Modify E-mail Options

Roles OLAP, Analysis, Programming, Advanced

Description If granted, the user can change the e-mail options for projects. If not
granted, the user can view the e-mail options, but cannot change
them.

Modify Performance Options
Roles Programming, Advanced

Description If granted, the user can change the performance options for projects.
If not granted, the user can view the performance options, but
cannot change them.

Modify All Options
Roles OLAP, Analysis, Programming, Advanced
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If granted, the user can modify the options that are listed in the
Options dialog box. If not granted, the user can view the options,
but cannot change them.

Tools and Help Capabilities

Access Unregistered Custom Tasks

Roles

Description

Modify Styles
Roles

Description

OLAP, Analysis, Programming, Advanced

If granted, by default the user can use custom tasks that are not
registered in metadata. Specific custom tasks might still be
disallowed. If not granted, the user cannot use custom tasks that
are not registered in metadata.

OLAP, Analysis, Programming, Advanced

If granted, the user can modify the styles that are used to create
reports. If not granted, the style Manager menu item is removed.

Create or Modify Schedules

Roles

Description

Analysis, Programming, Advanced

If granted, the user can create and modify scheduled projects. If not
granted, the Schedule Project and Schedule Process Flow
menu items are removed. If the user opens a project that contains a
schedule project node, the user cannot modify the settings for the
project.

Access SAS Enterprise Guide Explorer

Roles

Description

Advanced

If granted, the user can use the SAS Enterprise Guide Explorer
application. If not granted, the Enterprise Guide Explorer menu
item is removed. The user also cannot start the SAS Enterprise
Guide Explorer application directly, from outside of SAS Enterprise
Guide.

Assign Project Library

Roles

Description

Advanced
Enables the Assign Project Library task.

Update Library Metadata

Roles

Description

Advanced, Programming, Analysis
Enables the Update Library Metadata task.

Access Project Maintenance

Roles

Advanced
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Description If granted, the user can open the Project Maintenance dialog box,
which allows the user to rename servers and libraries throughout a
project. If not granted, the user cannot open the Project
Maintenance dialog box.

Access SAS Technical Support
Roles OLAP, Analysis, Programming, Advanced

Description If granted, the user can navigate to the SAS Technical Support Web
site from SAS Enterprise Guide. If not granted, the menu items
under SAS on the Web that link to SAS Technical Support are
removed.

Data Capabhilities

Append Tables
Roles Advanced, Programming, OLAP, Analysis
Description Enables the Append Tables task.

Delete Data Sets and Formats
Roles Advanced, Programming, OLAP, Analysis
Description Enables the Delete Data Sets and Formats task.

Compare Data
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Compare Data task.

Data Set Attributes

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Data Set Attributes task.

Create Format
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Create Format task.

Random Sample

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Random Sample task.
Rank

Roles OLAP, Analysis, Programming, Advanced
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Description Enables the Rank task.

Sort Data

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Sort Data task.

Standardize Data
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Standardize Data task.

Split Columns
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Split Columns task.

Stack Columns
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Stack Columns task.

Transpose a set of data
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Transpose task.

Download Data Files to PC

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Download Data Files to PC task.

Upload Data Files to Server
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Upload Data Files to Server task.
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List Report Wizard

Roles OLAP, Analysis, Programming, Advanced
Description Enables the List Report Wizard task.

Distribution Analysis
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Distribution Analysis task.
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Characterize Data

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Characterize Data task.

List Data

Roles OLAP, Analysis, Programming, Advanced
Description Enables the List Data task.

One-Way Frequencies
Roles OLAP, Analysis, Programming, Advanced
Description Enables the One-Way Frequencies task.

Summary Statistics
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Summary Statistics task.

Summary Tables
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Summary Tables task.

Table Analysis
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Table Analysis task.

Graph Capabilities

Contour Plot
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Contour Plot task.

Bubble Plot
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Bubble Plot task.

Radar Chart

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Radar Chart task.
Box Plot

Roles OLAP, Analysis, Programming, Advanced
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Donut Chart
Roles

Description

Area Plot
Roles

Description

Pie Chart
Roles

Description

Line Plot
Roles

Description

Bar Chart
Roles

Description
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Enables the Box Plot task.

OLAP, Analysis, Programming, Advanced
Enables the Donut Chart task.

OLAP, Analysis, Programming, Advanced
Enables the Area Plot task.

OLAP, Analysis, Programming, Advanced
Enables the Pie Chart task.

OLAP, Analysis, Programming, Advanced
Enables the Line Plot task.

OLAP, Analysis, Programming, Advanced
Enables the Bar Chart task.

Create Map Feature Table

Roles

Description

Surface Plot
Roles

Description

Map Graph
Roles

Description

Bar-Line Chart
Roles

Description

Tile Chart
Roles

OLAP, Analysis, Programming, Advanced
Enables the Create Map Feature Table task.

OLAP, Analysis, Programming, Advanced
Enables the Surface Plot task.

OLAP, Analysis, Programming, Advanced
Enables the Map Graph task.

OLAP, Analysis, Programming, Advanced
Enables the Bar-Line Chart task.

OLAP, Analysis, Programming, Advanced

45
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Description Enables the Tile Chart task.

Scatter Plot

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Scatter Plot task.

ANOVA Capabilities

Linear Models
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Linear Models task.

Mixed Models

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Mixed Models task.

Nonparametric One-Way ANOVA

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Nonparametric One-Way ANOVA task.
One-Way ANOVA

Roles OLAP, Analysis, Programming, Advanced
Description Enables the One-Way ANOVA task.

t Test

Roles OLAP, Analysis, Programming, Advanced
Description Enables the t Test task.

Regression Capabhilities

Generalized Linear Models
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Generalized Linear Models task.

Linear Regression
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Linear Regression task.
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Logistic Regression
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Logistic Regression task.

Nonlinear Regression
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Nonlinear Regression task.
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Multivariate Capabilities

Canonical Correlation
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Canonical Correlation task.

Cluster Analysis

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Cluster Analysis task.
Correlations

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Correlations task.

Discriminant Analysis
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Discriminant Analysis task.

Factor Analysis
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Factor Analysis task.

Principal Components
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Principal Components task.

Survival Analysis Capabilities

Life Tables
Roles OLAP, Analysis, Programming, Advanced
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Description Enables the Life Tables task.

Proportional Hazards
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Proportional Hazards task.

Capability Capabhilities

CDF Plots

Roles Advanced

Description Enables the CDF Plots task.
Histograms

Roles Advanced

Description Enables the Histograms task.
Q-Q Plots

Roles Advanced

Description Enables the Q-Q Plots task.

Probability Plots

Roles Advanced

Description Enables the Probability Plots task.
P-P Plots

Roles Advanced

Description Enables the P-P Plots task.

Control Charts Capabilities

Box Chart

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Box Chart task.

¢ Chart

Roles OLAP, Analysis, Programming, Advanced

Description Enables the ¢ Chart task.



Administering Role-Based Settings A Time Series Capabilities

Individual Measurements Ghart

Roles OLAP, Analysis, Programming, Advanced
Description Enables the Individual Measurements Chart task.
np Chart

Roles OLAP, Analysis, Programming, Advanced
Description Enables the np Chart task.

p Chart

Roles OLAP, Analysis, Programming, Advanced
Description Enables the p Chart task.

u Chart

Roles OLAP, Analysis, Programming, Advanced
Description Enables the u Chart task.

Mean and Range Chart
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Mean and Range Chart task.

Mean and Standard Deviation Chart
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Mean and Standard Deviation Chart task.
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Pareto Capabilities

Pareto Chart
Roles Advanced
Description Enables the Pareto Chart task.

Time Series Capabhilities

Forecast Studio Create Project
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Forecast Studio Create Project task.

Forecast Studio Open Project
Roles OLAP, Analysis, Programming, Advanced
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Description Enables the Forecast Studio Open Project task.

Forecast Studio Override Project
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Forecast Studio Override Project task.

ARIMA Modeling and Forecasting
Roles OLAP, Analysis, Programming, Advanced
Description Enables the ARIMA Modeling and Forecasting task.

Regression Analysis with Autoregressive Errors
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Regression Analysis with Autoregressive Errors task.

Basic Forecasting
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Basic Forecasting task.

Regression Analysis of Panel Data
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Regression Analysis of Panel Data task.

Prepare Time Series Data
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Prepare Time Series Data task.

Create Time Series Data
Roles OLAP, Analysis, Programming, Advanced

Description Enables the Create Time Series Data task.

Model Scoring Gapabilities

Model Scoring
Roles OLAP, Analysis, Programming, Advanced
Description Enables the Model Scoring task.
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Recommended Reading

Here is the recommended reading list for this title:
o SAS/ACCESS for Relational Databases: Reference
Getting Started with SAS Enterprise Guide
SAS Intelligence Platform: 9.1.3 to 9.2 Migration Guide
SAS Intelligence Platform: Data Administration Guide
SAS Intelligence Platform: Desktop Application Administration Guide
SAS Intelligence Platform: Installation and Configuration Guide
SAS Language Reference: Dictionary

O 0O 0o oo o

SAS Management Console: Guide to Users and Permissions

For a complete list of SAS publications, go to support.sas.com/bookstore. If you
have questions about which titles you need, please contact a SAS Publishing Sales
Representative at:

SAS Publishing Sales

SAS Campus Drive

Cary, NC 27513

Telephone: 1-800-727-3228

Fax: 1-919-531-9439

E-mail: sasbook@sas.com

Web address: support.sas.com/bookstore

Customers outside the United States and Canada, please contact your local SAS office
for assistance.


mailto:sasbook@sas.com
support.sas.com/bookstore
support.sas.com/bookstore
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Glossary

authentication domain
a SAS internal category that pairs logins with the servers for which they are valid.
For example, an Oracle server and the SAS copies of Oracle credentials might all be
classified as belonging to an OracleAuth authentication domain.

capability
an application feature that is under role-based management. Typically, a capability
corresponds to a menu item or button. For example, a Report Creation capability
might correspond to a New Report menu item in a reporting application. Capabilities
are assigned to roles.

connection profile
a client-side definition of where a metadata server is located. The definition includes
a computer name and a port number. In addition, the connection profile can also
contain user connection information.

database library
a collection of one or more database management system files that are recognized by
SAS and that are referenced and stored as a unit. Each file is a member of the library.

engine
a component of SAS software that reads from or writes to a file. Each engine enables
SAS to access files that are in a particular file format.

Integrated Windows authentication
a Microsoft technology that facilitates use of authentication protocols such as
Kerberos. In the SAS implementation, all participating components must be in the
same Windows domain or in domains that trust each other.

libref
a short name for the full physical name of a SAS library. In the context of the SAS
Metadata Repository, a libref is associated with a SAS library when the library is
defined in the metadata repository.

metadata LIBNAME engine
the SAS engine that processes and augments data that is identified by metadata.
The metadata engine retrieves information about a target SAS data library from
metadata objects in a specified metadata repository.
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metadata repository
a collection of related metadata objects, such as the metadata for a set of tables and
columns that are maintained by an application. A SAS Metadata Repository is an
example.

metadata server
a server that provides metadata management services to one or more client
applications. A SAS Metadata Server is an example.

repository
a location in which data, metadata, or programs are stored, organized, and
maintained, and which is accessible to users either directly or through a network.
See also metadata repository, SAS Metadata Repository.

role
a set of capabilities. In some applications, certain actions are available only to users
or groups that have a particular role.

SAS Metadata Repository
a repository that is used by the SAS Metadata Server to store and retrieve metadata.
See also SAS Metadata Server.

SAS Metadata Server
a multi-user server that enables users to read metadata from or write metadata to
one or more SAS Metadata Repositories. The SAS Metadata Server uses the
Integrated Object Model (IOM), which is provided with SAS Integration Technologies,
to communicate with clients and with other servers.

server
a computer system that provides data or services to multiple users on a network.
The term ’server’ sometimes refers to the computer system’s hardware and software,
but it often refers only to the software that provides the data or services. In a
network, users might log on to a file server (to store and retrieve data files), a print
server (to use centrally located printers), or a database server (to query or update
databases). In a client/server implementation, a server is a program that waits for
and fulfills requests from client programs for data or services. The client programs
might be running on the same computer or on other computers.

tasks
in Enterprise Guide, operations that correspond to SAS procedures and SAS
functions that analyze, manipulate, or display data. From the Task List you can
select the analysis and reporting tasks that you want to run on your data.
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Need to learn the basics? Struggling with a programming problem? You’ll find the expert answers that you
need in example-rich books from SAS Press. Written by experienced SAS professionals from around the
world, SAS Press books deliver real-world insights on a broad range of topics for all skill levels.

support.sas.com/saspress
SAS° Documentation
To successfully implement applications using SAS software, companies in every industry and on every
continent all turn to the one source for accurate, timely, and reliable information: SAS documentation.
We currently produce the following types of reference documentation to improve your work experience:
¢ Online help that is built into the software.
e Tutorials that are integrated into the product.
¢ Reference documentation delivered in HTML and PDF - free on the Web.
. -
Fard-copy books. support.sas.com/publishing
SAS’° Publishing News
Subscribe to SAS Publishing News to receive up-to-date information about all new SAS titles, author
podcasts, and new Web site features via e-mail. Complete instructions on how to subscribe, as well as

access to past issues, are available at our Web site.
support.sas.comlspn
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